
LinkMotion USB for CNC/Engraving Detail Installation and 
Setup Instructions 
 
LinkMotion CD is available for an extra charge for 32 and 64 bit operating systems of Windows. 
Use 32-bit version for installing on Win 10, 8.1, 8 or 7 32 bit and Win XP operating systems. 
Use 64-bit version for installing on Win 10, 8.1, 8 or 7 64 bit operating system. 
 
If you just purchased USB Controller board and the software, you may want to refer to the 
document - Connecting and Wiring AGNI USB Controller for the recommended wiring of the 
controller board in your system. Make sure and understand which controller you have to follow 
separate instructions for the 32-bit controller or older 16-bit controller. 
 
LinkMotion will only work on the computer with USB port 2.0 or higher and does 
not work with USB 1.1. Do not attach other USB devices like keyboard and mouse 
that has USB 1.1 otherwise LinkMotion will not work. 
 
Installation required for LinkMotion USB and USB controller driver: 
 
Part 1 – Installing LinkMotion USB for CNC/Engraving on Windows 10, 8.1 or 8 
requires to follow Disable driver signature requirement procedure just prior to installing 
LinkMotion. Then follow the first part of the installation of LinkMotion USB for CNC/Engraving 
software. Win 7 or XP users do not require Disable driver signature procedure so they can start installing 
LinkMotion software. 
 
Part 2 – Installing USB driver for AGNI Controllers: 
 
A: Install WinUSB Driver for New AGNI Controller Series 20000 on Win 8 and 10: 
 
New AGNI Controller Series 20000 now uses windows standard WinUSB driver. Windows 8 and 
10 operating system provides windows USB driver for recognizing all USB devices. If you do not 
have this driver you can go to Microsoft’s web site and download this driver. Then follow 
Confirming the WinUSB driver Installation instructions. Follow all the details from this manual. 
 
B: Install WinUSB Driver for New AGNI Controller Series 20000 on Win 7: 
 
Win 7 requires for you to download this driver from Microsoft’s website. Follow the detail 
instructions from the Part 2 of installation instructions in this manual. 
 
C: Install USB Driver for Older Agni Controllers series 10000: 
 
Older Agni Controllers series 10000 and under needed Install 32-bit AGNI USB driver or  16 bit 
USB driver. Please confirm which one you need to install before starting this part of the installation. 
Do not plug the USB cable into your computer until the written instruction guides you. 
 
 
 



Warning for USB Controller Serial Numbers:  
 
If USB Controller’s serial number is either not recognized (not certified) or not found when 
LinkMotion is launched it will display a message “ Unrecognized serial number ____”. When the 
user clicks on OK button it will also display a message “The maximum working area is 1’x1” or 
25.4mm x 25.4mm”. If the controller is not purchased from Solustan or Solustan approved dealer 
it can display this message “ Your controller is not certified. Please contact Solustan for help”. 
Contact Solustan for resolving this problem. G-Code Files tab(menu) also will not be available for 
processing previously generated g-code files. 
 
USB Controllers serial numbers can be programmed for limited table size output for testing the 
software in demo mode. When testing this demo software it will not allow the user to enter and 
save any larger table size in Machine properties area. It will not allow the user to send any jobs 
larger than the available table size. Make sure to test the jobs that fit within that available area. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Part 1 - Installation Procedure for LinkMotion USB for CNC/Engraving: 
 
Note that you must have administrative privileges on the computer or Administrator should install 
this in order to install LinkMotion properly. Please make sure that you are not running any software 
applications at the time of this installation. Various protection software needs to be turned off 
before installing this software. You can turn that back on after the installation is finished. Most of 
the installation process is self-explanatory by following the instructions on the screen. You can stop the 
installation at any time by clicking "Cancel". 
 
Windows 10, 8.1 and 8 users should follow Disable driver signature requirement procedure just prior to 
installing LinkMotion software as explained separately for each one in next few pages. Windows 7 and 
XP users can skip that part and go to LinkMotion installation part of the instructions. 
 
Installing on Windows 10, 8.1 or 8 operating system:        
 
Do not insert LinkMotion software CD (if you chose to receive the software on CD) until following 
procedure is done for Windows 10, 8.1 or 8. In Windows 10, 8.1 and 8 operating system, you must first 
disable the Driver Signature Requirement to install the LinkMotion driver. Once the Driver 
Signature Requirement is disabled the system will restart the computer and the user will be able to install 
LinkMotion driver using our installation instructions. Next time when the computer restarts the Driver 
Signature Requirement will default back to enabled. Once the LinkMotion driver is installed, you can 
install a new version of LinkMotion without having to disable it again in Windows. We have included 
separate instructions for Windows 8.1 and Windows 8. Please follow proper instructions for your 
computers operating system. 
 
Windows 10, 8.1 and 8 user interface has newer design and it is different than all previous version of the 
Windows. There is more than one way to go to the Control Panel and you should use what you are 
comfortable with. Control Panel can be selected by bringing the arrow of your mouse at the bottom right 
corner and select Settings. Under the settings, the second available selection is Control panel. Click on 
this and all Control Panel selections are available. Remember to use apply button and save information 
when you make any changes in the settings for it to be effective. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Disable Driver Signature Requirement under Windows 10: 
 
Go to Windows Settings dialog box by one of the following methods: 
 

(1) Click on the Windows Start button and select Settings. 
(2) Select All Apps selection above the Start button of Windows and select Settings. 
(3) Click on the No New Notification icon on the Systems Tray at the bottom right. Here click on 

the All Settings. 
 
You will see the dialog box for Settings as shown below. 
 
 

 
 
 
Click on the Update & Security, Windows Update, Recovery, Backup and you will see the following 
options shown in the picture below. 
 
 

 
 
 



Select Recovery on the left side and Click on the Restart Now button under Advanced startup on the 
right side. 
 
Here select Troubleshoot. 
 
Select Advance Options under Troubleshoot selection. 
 
Select Startup Settings under Advanced Options selection. 
 
Select the Restart button from the bottom right under Startup Settings selection. 
 
Now Computer will restart again and you will see a screen for Startup Settings with many selections 
available listed with numbers One through Nine as shown in the picture below. 
 
 

 
 
 
Press F7 or number 7 key on your computer keyboard when you see the screen as shown above. This 
will disable the Driver Signature Requirement. After you press F7 or 7 key your computer will start 
launching the operating system. After your operating system is launched follow the normal login 
procedure and install LinkMotion driver by following the installation instructions from the documents 
provided by Solustan. 
 
If for any reason you had to restart your computer before installing LinkMotion you need to start 
the Disable driver signature enforcement procedure again before you can install LinkMotion. 
LinkMotion printer driver will be installed only if this procedure is followed properly. 
 



Disable Driver Signature Requirement under Windows 8.1: 
 
Open the Charms Bar in Windows 8.1 by bringing the arrow of your mouse on the bottom right corner 
of your computer screen and select Settings (first at the bottom) as seen in the picture below. 
 
 

 
 
 
Once Settings is selected you will see the following screen and select Change PC Settings as shown 
below. 
 

 
 
 
Under Win 8.1 when Control Panel opens, select Update & recover section from the left side as shown 
in the picture below. 
 

 

 
 
 
Under Win 8.1 Click on the Recovery option on the left side as shown in the picture below. Once 
selected, you will see an Advance startup section on the right side. You will need to click on Restart 
now button. 

 



 
 
 
Now your computer will restart. Once the Computer has restarted, Choose an Option selection will 
be available. Here select Troubleshoot. 
 
Select Advance Options under Troubleshoot selection. 
 
Select Startup Settings under Advanced Options selection. 
 
Select the Restart button from the bottom right under Startup Settings selection. 
 
Now Computer will restart again and you will see a screen for Startup Settings with many selections 
available listed with numbers One through Nine as shown in the picture below. 
 
 

 
 
 
Press F7 or number 7 key on your computer keyboard when you see the screen as shown above. This 
will disable the Driver Signature Requirement. After you press F7 or 7 key your computer will start 
launching the operating system. After your operating system is launched follow the normal login 
procedure and install LinkMotion driver by following the installation instructions from the documents 
provided by Solustan. 
 
If for any reason you had to restart your computer before installing LinkMotion you need to start 
the Disable driver signature enforcement procedure again before you can install LinkMotion. 
LinkMotion printer driver will be installed only if this procedure is followed properly. 
 



Disable Driver Signature Requirement under Windows 8: 
 
Open the Charms Bar in Windows 8 by bringing the arrow of your mouse on the bottom right corner of 
your computer screen and select Settings (first at the bottom) as seen in the picture below. 
 
 

 
 
 
Once Settings is selected you will see the following screen and select Change PC Settings as shown 
below. 
 

 
 
 
Under Win 8 select General from the left side as shown in the picture below. 
 
 

 
 
 
Under Win8 Scroll to the bottom of General and select Restart Now under Advanced Start-Up from 
the right side as shown in the picture below. 



 

 
 
 
Now your computer will restart. Once the Computer has restarted, Choose an Option selection will 
be available. Here select Troubleshoot. 
 
Select Advance Options under Troubleshoot selection. 
 
Select Startup Settings under Advanced Options selection. 
 
Select the Restart button from the bottom right under Startup Settings selection. 
 
Now Computer will restart again and you will see a screen for Startup Settings with many selections 
available listed with numbers One through Nine as shown in the picture below. 
 
 

 
 
 
Press F7 or number 7 key on your computer keyboard when you see the screen as shown above. This 
will disable the Driver Signature Requirement. After you press F7 or 7 key your computer will start 
launching the operating system. After your operating system is launched follow the normal login 
procedure and install LinkMotion driver by following the installation instructions from the documents 
provided by Solustan. 
 
If for any reason you had to restart your computer before installing LinkMotion you need to start 
the Disable driver signature enforcement procedure again before you can install LinkMotion. 
LinkMotion printer driver will be installed only if this procedure is followed properly. 
 
 
 



Install LinkMotion driver software for CNC/Engraving: 
 
If you selected to receive the driver software on a CD, Go to the step (1A) and skip (1B).  
 
If you selected to receive the driver software by the internet, Go directly to the step (1B) and skip 
(1A). 
 
(1A) Insert the LinkMotion installation CD into your CD-ROM drive. If the Auto-run feature is 
enabled on your PC, Windows will start the Installation automatically. If the Auto-run feature is not 
enabled, browse the CD drive in Windows Explorer and double-click on the  
“LinkMotion_CNC64_Setup.exe” for a 64-bit version or  “LinkMotion_CNC32_Setup.exe” for a 
32-bit version or “Setup.exe” and installation will begin.  
 
(1B) After downloading the LinkMotion driver software, unzip the files and save by creating a folder 
name LinkMotion. Now double click on the file name “LinkMotion_CNC64_Setup.exe” for a 64-bit 
version or  “LinkMotion_CNC32_Setup.exe” for a 32-bit version or “Setup.exe” and installation 
will begin. 
 
(2) Click on the Next Button. 
 

 
 
 (3) Click on the Next Button. 
 
 

 
 
 

(4) When you get to the License Agreement dialog (see above), you must read the agreement. If you 
agree, go ahead and click the radio button "I Agree" for the installation process to continue and Click 
on the Next Button. 
 

 



 
 
(5) After you have read and agreed to the License Agreement, you will be asked to specify the 
installation folder. In most cases, you can leave this as the default setting.  
 
(6) Click on the Next button once again. 
 

 
 
 
(7) Later during the installation, you will see Choose your machine for installation. The default 
machine name is My Machine. Scroll on the arrow to the right and many more machine names are 
available. Please choose your machine name. If you wish to add your machine name that you do not 
see here, Please contact us.  
 
Do not create or write your own new machine name here at the time of this installation. 
 
 

 
 
 
(8)  You will see a message shown below before this installation is complete. Here select Install this 
driver software anyway to make sure that LinkMotion printer driver for your machine gets installed 
properly. Name of the printer driver will be the name of the Machine you select from the above 
selection. Sometime this message may appear in the background of another message and you need 
to make sure to bring them in the foreground and make the proper selection for Installing this 
driver software anyway is done. It will not install the printer driver if this was not followed 
properly. 
 
 

 
 
 
(9)  The message displayed below is a reminder to Re-launch Linkmotion one time after installation is 
finished for the driver to be recognized properly and Click on the OK button here. Make sure to click 
on the OK button after you click on the “Install this driver software anyway”. 



 
 
 

 
 
 
(10) Click "Close" when the installation is complete as shown below. 
 

 

 
 
 
The icon shown below should show up in the system tray at the bottom right. If LinkMotion icon does 
not show up in the systems stray in case of Win 10, 8 and 7 follow directions from below and setup to 
view that icon all the time. 
 
Go to Control Panel of windows from the Start button. Click on the Appearance and 
Personalization. Go to the Taskbar and Navigation(Win 10), Taskbar(Win 8), Taskbar and Start 
Menu(Win 7 and XP). Click on the (Notification area on Win 10) Customization on the taskbar.  
Win 10 - Click on Select which icons appear on the taskbar. Here check LinkMotion icon to be on. 
Win 8, 7 - Here click on the box at the bottom left for Always show all icons and notifications on the 
taskbar. Click on the OK button. 
 
 

 
 
 

To view all different files and folders that are installed for LinkMotion one more setup is 
necessary using following directions in Win 10, 8 and 7: 
 
Go to Control Panel and click on the Appearance and Personalization. 
Under Folder Options Click on the Show Hidden files and folders. 
In the View section, look for Hidden files and folders. 
If not checked already, check the button for Show hidden files, folders and drives. 



Click on the Apply button. Click on the OK button.  
 
(11) Power Option Settings: 
 
Windows 10, 8 and 7: Windows 10, 8 and 7 operating system disables USB port connections when it is 
in power save or screen saver mode. Following settings will keep USB port always active. Please make 
sure to set this up properly. Power save mode can be turned off. 
Go to Control Panel > Click on Hardware and Sound > Under Power Options Click on Change 
when the computer sleeps(Win 10, 8 or 7), Change Power-Saving Settings(Win 10, 8 or 7) > 
Balanced is selected by default. On the right Click on Change Plan Settings(Win 10, 8 or 7) > Select 
Never for put the Computer to sleep by scrolling on the arrow. Click on the Change advanced power 
settings from below > Double click on the USB Settings > Double click on the USB Selective 
Suspend Setting > Click on the Settings and Select Disable (for Desktop computers) or Select Disable 
for On battery as well as Plugged in (for Laptops) > Click on the Apply button and Click OK. 
 
Windows XP: Go to Control Panel > Power Options > Under Power Schemes select Never for 
System Standby as well as System hibernates and Ok will save this setting. 
 
(12) Setting up the Default Printer: 

 
You want the LinkMotion printer to be your default printer. Open the Control Panel > View devices and 
printers(Win 10, 8 or 7) or Printers and Faxes menu(Win XP) and find under printer “My Machine-
USB” name as shown in the picture below. Right-click on this printer and select "Set as Default 
Printer". This name may be different if you selected your machine name. We give you a choice for 
selecting the machine name at the time of the installation with a scrolling arrow on the right side. 
 
Do not create or write your own new machine name here at the time of this installation. 
 
 

 
 
 
(13) Multiple users: 



 
Under Windows 10, 8.1, 8 and 7 LinkMotion version 4.06 onwards allows multiple users to use 
LinkMotion for the same computer. Installation of the LinkMotion.INI and temp.txt file locations 
have been moved to the following locations: 
C:/ProgramData folder > Solustan folder > LinkMotion folder > LinkMotion.INI file and BMP files. 
C:/ProgramData folder > Solustan folder > LinkMotionUSB folder > Tempfiles folder > temp.txt file. 
The previous user should always log off before another user logs on and starts using LinkMotion. 
 
Under Windows XP version 4.06 onwards, LinkMotion.INI and temp.txt files are installed in the 
following locations:  
C:/Document and Settings folder > All Users folder > Solustan folder > LinkMotion folder > 
LinkMotion.INI file. 
C:/Document and Settings folder > All Users folder > Solustan folder > LinkMotionUSB folder > 
tempfiles folder > temp.txt file.  
Windows XP has the limitation to allow only one user to use LinkMotion properly. Please make 
sure to install properly for one user only. 
 
(14) International Customers need to check following: 
 
If you are using Windows operating system for other languages please make sure that following settings 
are selected for LinkMotion to work properly. 
 
Win XP:  Go to the Start button > Control Panel > Regional and Language Options > Click on the 
Customize button. Here Decimal Symbol should be.(Full stop or Period) selected. Do not 
select,(Comma). If you had to change click on the Apply button and Click OK.  
 
Win 10, 8 users need to figure out to see the Control Panel and then follow Win 7 instructions. 
Win 7 32/64:  Go to the Start button > Control Panel > Clock, Language, and Region > Click on 
Change input methods(Win8) or Change keyboards or other input methods(Win7) > Select 
Format tab(menu) > Click on the Additional settings button. Here Decimal Symbol should be.(Full 
stop or Period) selected. Do not select,(Comma). If you made any change it is important to click on the 
Apply button and Click OK.  
 
You are done with all settings for windows. LinkMotion installation procedure is complete and now 
follow the USB controller driver installation procedure. When USB controller driver is not installed, 
LinkMotion will not find the controller so you will see the following message if you launch LinkMotion. 
Once the USB Controller driver is installed properly you will not see this message when you launch 
LinkMotion. 
 
 

 
 



 
Re-Launch LinkMotion: 
It is extremely important to Re-Launch LinkMotion first time after installing and then if you 
replace or change LinkMotion.INI file for it to be effective.  It is also important to Re-launch when 
you change the machine’s table size or DPI selection for LinkMotion USB Laser product. 
 
Exit the LinkMotion (icon) applet with a right mouse click from the systems tray at the bottom 
right.  LinkMotion icon should go away from the systems tray. 
 
Now launch it back again by following and selecting the path Windows Start button>Program 
Files or All Programs >Solustan>LinkMotion by the arrow of your mouse. 
 
LinkMotion icon should appear again in the systems tray at the bottom right. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Uninstalling LinkMotion: 
 
Please make sure of the following before you uninstall: 
 
Your specific machine related settings are saved as LinkMotion.ini file. This file can be saved from 
General Options Menu and simply click on the Save button. It is preferred that you give this file a 
unique name and save it properly to make it easy to retrieve it in future. Different users can save under 
different names. Similarly, you can Load that file back after another installation of LinkMotion by going 
to the General Options menu in LinkMotion and clicking on the Load button. Restore Default button 
allows you to load default original INI file that is supplied with LinkMotion. It is very important to 
exit LinkMotion applet and Re-launch the applet when you make any changes for it to be 
effective. Understand the definition of Re-Launch from below. 
 
Please make sure of the following before you Re-Install: 
 
LinkMotion is a Windows compatible driver. It does not need to install or uninstall frequently.  
However, if it is required to re-install the driver, the following are useful pointers to remember. 
 
There is not an easy way to remove and install a new version of the driver in Win XP operating system. 
It is necessary to go through uninstall described in our documents. Additionally, there may be a Need to 
manually remove Files from various Windows directories in the PC. 
 
Both, Win 10, 8, 7 32 and 64-bit versions are well organized to make fresh installations of the same or 
newer versions of LinkMotion. 
 
1. It is not proper and will not help to uninstall and install the same version of the LinkMotion one after 
another if you find it to be not working properly. 
 
2. Windows 10, 8, 7 does not allow removing of an installed driver and re-installing of the same driver 
unless necessary changes are made to the driver installation software. 
 
3. In case of going back and forth between earlier and newer driver software, the system may be armed 
with incompatible versions of the driver and applet. This is likely to cause more problems. 
 
4. Once a driver is installed in Win 10, 8 and 7 system, it is permanent. The driver cannot be unloaded 
easily. The operating system is more robust and more stable as a result. 
 
5. The best thing to do is to understand the structure of the driver. It is dictated by Windows and 
Microsoft websites can be very useful in understanding drivers. 
 
6. We will only discuss what is important here. Every driver is made available with an LMVC64*.inf 
file. This file controls the installation of the driver. 
 
7. Once you install a LinkMotion driver, a driver instance is created in the appropriate folders of 
Windows 10, 8 and 7 system. If it is needed to re-install LM USB Laser, LM USB or LinkCAM, take 
the following steps: 
 
A. Open the file LMVC64.inf  in any editor. 
 



B. Find the line “DriverVer=06/24/2011,1 “ with the date and installation number. 
 
C. If possible, change it to today's date. 
 
D. If it is the same date, change the number at the end of the line. 
 
E. Save the file. 
 
F. Now, when you uninstall, the older installation, it will remove applet and other files. However, it will 
archive the last version of the driver. 
 
G. The new installation will install a new version of the driver as long as the date or the instances are 
different and newer than the previous installation of the driver. 
 
H. There is going to be matching driver and applet in the system. 
 
J. It is important to make sure that the firmware in the USB controller matches the proper version of the 
LM software. 
 
Uninstall LinkMotion Procedure: 
Make sure the LinkMotion applet is closed. Open the Start menu and select the Control Panel. 
Double-click on Add or Remove Programs. Look for LinkMotion entry in the list and click on that. 
Select "Remove" and answer "Yes" when it asks you if you really want to remove LinkMotion. 
 
LinkMotion.INI file (configuration file) does not get deleted by uninstalling procedure.  
 
If you want to delete your existing INI file following is the procedure for Win 10, 8 or 7: 
 
LM version 4.06 and higher: C:/ProgramData folder > Solustan folder > LinkMotion folder > 
LinkMotion.INI file and BMP files. 
 
LM Version 4.05 and lower: In the C:\ hard drive Find folder name Users> Folder with users (your 
own name) name> Folder name AppData> Folder name Roaming>Folder name Solustan> Folder 
name LinkMotion> LinkMotion.INI. Delete this file. 
 
If you want to delete your existing INI file following is the procedure for Win XP: 
 
LM version 4.06 and higher: C:/Document and Settings folder > All Users folder > Solustan folder > 
LinkMotion folder > LinkMotion.INI file. 
 
LM Version 4.05 and lower: In the C:\ hard drive Find folder name Document and Settings> Folder 
with users (your own name) name> Folder name Application Data> Folder name Solustan> 
Folder name LinkMotion> LinkMotion.INI. Delete this file. 
 
Read and understand detail from the full manual before operating your LinkMotion 
driver software for CNC/Engraving machine product. 
 
 
 



Warnings for LinkMotion Control Pad: 
 

1. Use the ‘Zero (Ins)’ key on your Numeric Key Pad or quickly press ‘Space Bar’ to Pause 
the machine operation. LinkMotion needs to be in the foreground and in an active mode 
when Pause operation is exercised using PC keyboard. Spacebar pressed for a long time 
will also pause the job but it will pause in a momentary mode where the job will continue 
when Spacebar is released. When Pause activated with zero or quickly pressed space bar, a 
message box will come up for a decision to Continue or Quit the job. (Sometimes this 
message box is in the back of your Control pad and you may have to bring it to the front 
simply by clicking on the system tray’s active LinkMotion application.) At this point, make 
the necessary selection. Click YES to continue the job or No to stop the job completely. 
After you select NO you will see another dialog box asking you if wish to quit and stay in 
the position you are or you wish to go back to X, Y (0, 0) position. Make your selection and 
park your tool head properly.  

2. When pause is called for during a raster (engrave) operation, the pause will not take place 
until the laser beam reaches one of the ends of the active scanning line. 

3. Control Pad for LinkMotion allows only one direction movement at a time. Only use your 
computer keyboard (numeric keypad) for these movements. Do not use a mouse and click 
on the arrows of your Control pad screen. If you do, it will activate the ‘nudge’ feature. 

4. A single mouse click is used to exercise the ‘nudge’ feature. The mouse may be used for just a 
few Control Pad functions. These are, 
- Click Home button to activate the home sequence. 
- Click Repeat button to repeat the previous job. 
- Click one of the Pause buttons to pause the job processing operation 

5. Once a job is sent or you have activated the LinkMotion applet, it shows up in the bottom bar 
where active applications are displayed.  

6. Repeat Key from Control Pad (either of the Enter keys from computer keyboard) will process 
immediately the last job sent to the controller without sending the job again from the PC to the 
controller. 

7. Wireless keyboard and wireless mouse should be checked fully before using them. One of 
the possible problems with the wireless keyboards is that Control pad keys may not send 
out information fast enough for the machine to move properly. 

8. We have done preliminary testing with the wireless control pad and most keys function well 
when an individual key is pressed. When two keys are pressed together, it may not work 
properly. An example is pressing one directional key 6 to move the X-axis going to the right and 
then try pressing key 5 while holding down the key 6 to make it go faster may not work well. 

9. Design using plate size in the Materials Properties Tab is fully tested only with Corel Draw. 
If you are using any other design application you need to test before you start using the 
feature. 

10. How to use LinkMotion with different design applications: 
Zero or thinnest line (hairline) width and No fill are the most important things to remember when  
you are designing a file for Vector output. Do not fill the shape for any vector output. Thicker 
lines or filled object can be used only for raster output from LinkMotion Laser products. 
 
Page size in your design application should be smaller or same as your machine’s table size 
declared in Maximum travel declared for X and Y axis in Machine setup of LinkMotion. 
Job output will be where you see the design on the screen if the page size is same as your 
table size. 



 
Visit  www.solustan.com/support and Download Following Documents:  
LinkMotion and USB controller 
LinkMotion and Corel Draw or Design application you are using….. 
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All the keys are active when LinkMotion Control Pad is in foreground on the screen except the keys 
for Speed + (Up) and Speed - (down). Speed Up and Speed Down keys are effective when job is in 

process and machine is moving. Speed up key will not go to any higher speed then what you have 

declared in the Job feed rate of Materials Menu.

When jogging X and Y axis and pressing the Fast Key at the same time will double the speed of jogging. 

Typically, when jogging action takes place, the jogging speed will be 50% of the declared jogging speed 

in the Materials Menu of LinkMotion. Upon depressing Fast Key while holding down the directional key 

for jogging, the machine will jog at full speed or twice the speed of normal jogging.

Use Zero key or Quickly pressed Space Bar of your keyboard to Pause. Control Pad needs to be in 
the foreground and active mode for pause to be effective for LinkMotion product. Space bar pressed 
for a longer time will also pause the job but it will pause in a momentary mode where job will 
continue when Space bar is released. When Pause activated with zero or quickly pressed space bar, you 

will see a message box asking you if you want to Continue or Quit the job. Sometimes this message box 

is in the back of your Control Pad and you can bring it to the front simply by clicking on the systems tray’s 

active LinkMotion application. Click Yes to continue the job or no to stop the job completely. If you 

selected no and job was stopped, it will also ask you if you wish to stop where you are or you can select 

to go back to the starting position. Repeat Key will process immediately the last job sent to the controller 

without generating and then sending the job again from the PC to the controller.

WARNING: Do not use the arrow keys elsewhere on the keyboard in place of the Control Pad Keys. 
It may cause unpredictable results. Do not keep Num Lock key pressed or do not click many times at a 

fast speed. You need to gently press and release and observe the speed increase or decrease. 

Wireless keyboard and mouse are not recommended. In case of wireless, Control pad keys do not send 

out information fast enough for machine to move properly. We have done preliminary testing with wireless 

control pad and most key functions work well when individual key is pressed. When two keys are pressed 

together it does not work. An example - Press one directional key 6 to move the X axis going to the right 

and then press 5 key to make it go faster. Test your wireless devices like keyboard, mouse or numeric 
key pads fully before using them for production work.

 



Part 2 – Installing USB driver for AGNI Controllers: 
 
A: Installing WinUSB driver on Windows OS 8 and 10 for New AGNI 
Controller Series 20000: 
 
Windows 8 and Windows 10 are shipped with proper and flexible USB drivers. 
 

1. Connect the new Agni Series 20000 Controller to a USB connection on the PC with one of 
the above operating systems. 

2. The operating system will inform you that it is looking for the proper USB drivers to invoke 
and install necessary resources. 

3. It may take a while based on the speed of the PC. It will announce that the resources are 
found and the USB device is ready for the operation. 

4. That is all there is to it. 

Once the USB driver is installed, the name USB device will change to Machine Link II. This name is 
assigned to Solustan’s controller. From now on, every time the controller is connected to the USB 
connector of the PC, the Device Manager will bring up the Machine Link II and will establish the 
connection at the USB level. This procedure only needs to be done once. 
The LinkMotion printer driver will use the USB device driver to communicate with the Agni controller. 
It is important to understand that various parts are installed for the LinkMotion to perform its tasks. 
 

1. USB Device Driver 
2. LinkMotion Printer Driver 
3. LinkMotion User Interface and Control Pad. 
4. Corel Draw type design application. 

 
Now follow Confirming the USB Driver installation after the Win7 USB Diver instructions. 
 
 

B: Installing WinUSB driver on Windows OS 7 for New AGNI Controller 
Series 20000: 
 

Win7 ships with the correct 'winusb.sys' file, but is missing an updated '.inf' file that 
associates the driver with "usb\ms_comp_winusb" devices. Normally if the USB device 
supports Microsoft OS descriptors, then it will allow Windows to automatically install the 
WinUSB driver. This mechanism is supported "in-box" for Win8 and newer. For Win7 
the mechanism is supported through Windows update. Depending on the update policy 
for the Win7 machine, the appropriate driver may or may not be already available on the 
machine. If it is not already on the machine, user can use the following manual procedure 
to install the driver if necessary. 
 



1. Search for "windows phone winusb" at [Microsoft®Update 
Catalog|https://www.catalog.update.microsoft.com/Home.aspx]. 

2. Download "Windows Phone - Other hardware - WinUsb Device". 
 
NOTE: 
Solustan took care of the above two steps. Downloaded the software and attached it 
herewith. 
 

3. Extract the contents of the downloaded '.cab' file to a temporary folder. In other 
words unzip it. 

4. Open the Windows Device Manager on the PC screen. 
5. Connect the Agni II controller to any USB port on the PC. Note that a new USB 

Device is added under the listings of the USB (Universal Serial Bus) controllers.  
6. Right Click the mouse to the new Device line in the Device Manager and select 

"Update driver software ..." -->  
7. When choices show up, select "Browse my computer for driver software". 
8. Navigate to the temporary folder with the downloaded driver to complete the 

installation. 

Once the USB driver is installed, the name USB device will change to Machine Link II. 
This name is assigned to Solustan’s controller. From now on, every time the controller is 
connected to the USB connector of the PC, the Device Manager will bring up the 
Machine Link II and will establish the connection at the USB level. This procedure only 
needs to be done once. 
The LinkMotion printer driver will use the USB device driver to communicate with the 
Agni controller. 
It is important to understand that various parts are installed for the LinkMotion to 
perform its tasks. 
 

5. USB Device Driver 
6. LinkMotion Printer Driver 
7. LinkMotion User Interface and Control Pad 
8. Corel Draw type design application. 

 
Now follow Confirming the USB Driver installation from the next page. 

 
 
 
 



Confirming the WinUSB driver installation for new AGNI Controllers 
Series 20000: 
 
Now confirm proper connection to this new USB Controller device by going to the Device 
Manager of Windows as shown in the following picture.  
 
 

 
 
 
Name of the device once installed will show as  “WinUsb Device” and it will show the proper name 
“Machine Driver Link II” after the restart of the operating system. As long as it is connected 
properly it will display any one name. If windows standard USB device driver is not properly 
installed it will not display this name and will not communicate with new AGNI USB Controller. 
Please make sure and install proper driver for USB device. 
 



Another way to confirm under Devices of Windows Devices as shown in 
the picture below: 
 
 

 
 
 
 
IMPORTANT INFORMATION: 
 
After installation of LinkMotion sofware and proper USB device driver, when you connect the 
AGNI USB controller it should display a windows standard message about recognizing new USB 
device. Always make sure you see this message, close that message and then launch LinkMotion. It 
will not connect with this USB Controller properly if you do not follow proper procedure. 
 
Re-Launch LinkMotion means exit LinkMotion Icon from the systems tray on the bottom right by 
right mouse click and then launch it back on the systems tray by going to the Windows start button and 
All programs, Solustan, LinkMotion. 
 
 
 
 
 
 
 
 
 



Warnings for New USB Controller board Series 20000 and higher: 
 

1. Plug the LinkMotion controller cable directly into your computer’s USB 2.0 connection. 
2. It is important to experiment and determine that the USB controller works with the USB hub or 

extension device if the user plans to use such a device. 
3. This USB controller does not work with USB1.1 connections. If you connect other USB devices 

compatible only with 1.1, it may cause problems. All the USB devices including keyboard and 
mouse in the system shall comply with 2.0 specifications. Always check compatibility for 
wireless USB devices, if you are using one. 

4. Power saver and Screen Saver modes on your computer should be turned off. If these modes are 
activated, it can cause problems in recognizing the USB connection on a continuous basis. 

5. The LinkMotion USB controller can be configured to power either from the USB connection of 
the PC or from an external 5 VDC power supply. There is a jumper on the controller board that 
allows the selection of the power supply for the controller. 

6. In case of Laptop computers, AC power unit shall be connected to an AC outlet while operating 
external USB devices. Sometimes, aggressive power save mode settings under battery operations 
could activate the disconnection of USB devices. Re-Launching LinkMotion will re-activate the 
communication in such a situation. 

7. Approximately 1 minute of machine operation uses 1MB of SD memory for vector work. This 
controller supports up to 4GB Memory. If you are using LinkMotion version 3.5 or higher, you 
could use either SD or SDHC memory cards. 

8. It is impossible to test all the available SD Memory cards in the market but we have listed in the 
following lists ones that work and ones that do not work with this USB controller. 

 
Memory chips tested and working with this controller: Sandisk 4GB, PNY 4gb SDHC, Samsung 1gb, 
Transcend 1gb and 'Made in China Generic' 1gb. 
Memory chips found not working with this controller: Kingston 2gb (not SDHC) and 4gb SDHC. 
 

9. If serial number of the controller is not recognized by LinkMotion then user will see a message 
“Unrecognized serial number ______”. Once you click on OK button it will display the second 
message as “The maximum working area is 1”x1” or 25.4mm x 25.4mm. LinkMotion software 
can output only 1”x1” jobs at that point. Unauthorized controller bought from unauthorized 
vendors can cause this kind of problem. Get in touch with Solustan to verify your serial number. 
Not making proper USB connection with the controller can also display this kind of message and 
simply disconnecting USB cable form computer end and reconnect and re-launch LinkMotion 
should resolve it. 
 

      10. USB Controller Board Lights: 
There is only one LED lights available to attach to the new Agni Controller board Series 20000 – Blue. 
This light will behave in the following manner when connections are made and the board is powered: 
 
Blue LED – Steady Blue light means USB powered up and ready. If blue light flases fast it means it is 
waiting to make the USB connection. At this point, If you launch LinkMotion app it should become 
steady. If Blue light is flashing slowly it means it is in boot load mode. 
 
We have an additional programmable LED connections available. We will inform you as we add more 
LED and its functions. 
 



C: Installing Older AGNI Controller driver for Series 10000 and under - Install 
(32bit) AGNI USB Controller driver or 16 bit USB Controller Driver:  
 
Do not plug the USB controller using the USB cable until it is asked for in the instructions. Always plug 
the controller directly into your computer’s USB 2.0 connection when instructed.  
 
If the controller is plugged into the PC via USB hub or other extension devices, it is important to 
note that the third party devices should meet USB 2.0 specifications. If the hubs or other extension 
devices cause problems, connect the controller directly to the PC to isolate USB related problems.  
 
(1) If you received new 32-bit AGNI USB Controller then follow the instructions from the document 
Install 32bit AGNI Controller Driver (available from the year 2015). 
 
(2) Older 16 bit USB Controller or Controller supplied for upgrade kit with Amp V, IV with USB 
interface needs 16 bit USB Driver. Installation method is similar but the name of the installation file 
and driver versions are different. Make sure to follow proper instructions as explained in the second 
section. 
 
 
 
(1) Installing 32-bit AGNI USB Controller driver for Win 10, 8, 7 - 32 or 64 and 
Win XP Operating System: 
 
Make sure your LinkMotion CD is on the computer. If you receive the software from the internet you 
should unzip and find a folder name USB Controller Driver and follow the instructions from step (3). 
 

 
 
 
1. Go to the start button of Windows at the bottom left and Click with the right mouse button and 
select Explore. 
  
2. Navigate and select LinkMotion CD or downloaded folder and find the folder name USB 
controller driver and open this folder. There are two files in this folder. Use 32-bit AGNI USB 
Driver 1.0.0.0.exe for AGNI USB Controller installation.  
 
 



 
 
 
3. Double click on the AGNI USB Driver 1.0.0.0.exe file for AGNI 32 bit controller. Your computer 
setup may ask for special permission to install unknown vendor and you can click on the Yes button to 
start. 
Click on the Next button when the following screen is displayed. 
 
 

 
 
 
4. You will see the following two screens as installation is in process. Click on Install button on the 
second screen for Windows Security. 
 
 

 
 
 



 
 
 
5.  When you see the dialog box for Device Driver Installation Wizard, click on the Next button. It just 
takes a few seconds to install the USB driver. When the installation is finished you will see the 
following screen and click on the Finish button. 
 
 

 
 
 
6. Now plug in the USB cable. When you plug the USB cable into the computer you will see a message 
for found new hardware at the bottom right in the systems tray or the screen. Double Click and open it. 
 
The dialog box is shown in Windows 10, 8, 7: 
 
 

 
 

 
The dialog box is shown in Windows XP: 
 

 



 
7. On Win 8 and 7 first dialog box shown above will be displayed and it can automatically search and 
then install the driver from your computer. The user can save time by clicking on the message Skip 
obtaining driver software from Windows Update and click Yes on the next message(picture not 
shown). On Win XP Found new hardware wizard dialog box shows up and make sure to check the 
button for Install software automatically (Recommended). Click on the Next button. 
 
You will see the installation procedure collecting and installing the necessary files in proper locations. 
 
The dialog box is shown in Windows 10, 8, 7: 
 

 
 
 
The dialog box is shown in Windows XP: 
 
 

 
 
 
8. When it finishes automatic installation you will see the message shown above for Win 7, 8 and 10. 
Click on the Close button. On Win XP it displays different display and clicks on the Finish button 
here. 
 
9. The proper installation of 32-bit AGNI USB Controller driver “ AGNI USB Controller ” driver can 
be checked and confirmed if the device will work properly in the Windows Device Manager. 
 
Properly installed AGNI USB Controller under Device Manager will show as Solustan Machine 
Controller and Machine Driver Link under that. Double click on Machine Driver Link and it should 
show you a message This device is working properly if it is installed properly. This is a driver for 
Communication with the USB Controller and it is not a printer driver.  
 
Under Win 10, 8 and 7 users can see it installed as shown in the picture below in Hardware and 
printers area. This driver does not display on the Windows XP operating system. 
 
 



 
 
 
If it is not installed properly please make sure to check your cable connection, follow proper procedure 
or contact Solustan. 
 
10. Remember to plug in the compatible SD memory card into the USB Controller card. 
Approximately 1minute of machine work uses 1MB of memory. This controller supports up to 2GB 
Memory. We have provided the list of SD memory we have done testing with. 
 
If you are installing for the first time you do not need to worry about next step for updating the 
firmware. We ship all USB controller boards with the latest firmware.  
 
11. Firmware update for AGNI USB Controller board: 
 
This procedure may be necessary only when we send you an updated firmware or updated 
LinkMotion driver software to work with the latest firmware properly.  
 
Exit LinkMotion from the bottom right by right mouse click on the LinkMotion Icon. Now 
disconnect USB cable from the computer end, wait a minute and re-connect back one time. 
Firmware update requires USB controller board connected to the computer.  
Double click on the file name AGNI Updater 3060.exe or with the latest number that we have provided.  
Click on the big button AGNI FirmwareUpdater 3060. This will take a few seconds and when it is 
done updating it will give you a message Update Successful. Click on the OK button and unplug and 
replug the USB cable to recycle the power of USB Controller and you are done with the firmware 
update.  
 
If you are simply updating the USB controller board firmware or updating the LinkMotion driver 
version then you will simply need to exit the LinkMotion applet by right mouse click and Re-Launch it 
from the Start menu and start working with it again. 
 
Make sure and understand the LinkMotion driver features and then start working on your 
machine. 
 
 
 
 



(2) Installing 16 bit USB Controller driver for Win 10, 8, 7 - 32 or 64 and Win XP 
Operating System: 
 
Make sure your LinkMotion CD is on the computer. If you receive the software from the internet you 
should unzip and find a folder name USB Controller Driver and follow the instructions from step (3). 
 

 
 
 
1. Go to the start button of Windows at the bottom left and Click with the right mouse button and 
select Explore. 
  
2. Navigate and select LinkMotion CD or downloaded folder and find the folder name USB 
controller driver and open this folder. There are two files in this folder. Use 16 bit USB Driver-
0.9.9.5.exe for your controller.  
 
Older 16-bit controller and Solustan’s Upgrade kit with Amp V or IV module with USB interface 
uses 16-bit controllers. 
 
 

 
 
 
3. Double click on the USB Driver 0.9.9.5.exe file for the 16-bit controller. Your computer setup may 
ask for special permission to install unknown vendor and you can click on the Yes button to start. 
Click on the Next button when the following screen is displayed. 
 
 

 



 
 
4. You will see the following two screens as installation is in process. Click on Install button on the 
second screen for Windows Security. 
 
 

 
 
 

 
 
 
5.  When you see the dialog box for Device Driver Installation Wizard, click on the Next button. It just 
takes a few seconds to install the USB driver. When the installation is finished you will see the 
following screen and click on the Finish button. 
 
 

 
 
 
6. Now plug in the USB cable. When you plug the USB cable into the computer you will see a message 
for found new hardware at the bottom right in the systems tray or the screen. Double click and open it. 
 
The dialog box is shown in Windows 10, 8, 7: 
 
 



 
 
The dialog box is shown in Windows XP: 
 

 
 

7. Found new hardware wizard dialog box shows up and make sure to select the button for Browse my 
Computer for Win 10, 8.1, 8 and 7 or Install the software automatically (Recommended) for Win 
XP. Click on the Next button. Do not allow for windows to look for the driver on the internet. 
 
The dialog box is shown in Windows 10, 8, 7: 
 

 
 
The dialog box is shown in Windows XP: 
 

 
 
8. You will see the first screen above on Win 8 and 7 and click on the message “ Skip obtaining the 
driver software from Windows Updates”.  
The second screen shown above will be seen on Win XP. You will see the installation procedure and 
collect and installing the necessary files in proper locations.  
 
The dialog box is shown in Windows 10, 8, 7: 
 

 
 



The dialog box is shown in Windows XP: 
 

 
 
9. When it finishes automatic installation you will see the message shown on the first screen above for 
Win 10, 8 and 7. The second screen will be displayed in case of Win XP. Click on the Close button. 
 
10. The proper installation of 16 bit USB Controller driver can be checked and confirmed if the device 
will work properly in the Windows Device Manager. 
 
The properly installed driver will show as OEMTech CNC Controllers and ncPOD under that. Double 
click on ncPOD and it should show you a message This device is working properly if it is installed 
properly. This is a driver for Communication with the USB Controller and it is not a printer 
driver. 
 
Under Win 10, 8 and 7 users can see it installed as shown in the picture below in Hardware and 
printers area. This driver does not display on the Windows XP operating system under printers. 
 

 
 
If it is not installed properly please make sure to check your cable connection, follow proper procedure 
or contact Solustan. 
 
11. Remember to plug in the compatible SD memory card into the USB Controller card. 
Approximately 1minute of machine work uses 1MB of memory. Old 16bit USB controller supports up 
to 2GB memory. We have provided the list of SD memory we have done testing with. 
 
If you are installing for the first time you do not need to worry about next step 12 for updating the 
firmware. We ship all USB controller boards with the latest firmware.  
 
12. Firmware update for USB Controller board: 
 
This procedure may be necessary only when we send you an updated firmware or updated 
LinkMotion driver software to work with the latest firmware properly.  
 



Exit LinkMotion from the bottom right by right mouse click on the LinkMotion Icon. Now 
disconnect USB cable from the computer end, wait a minute and re-connect back one time. 
Firmware update requires USB controller board connected to the computer.  
Double click on the file name FirmwareUpdater 2078.exe or with the latest number that we have 
provided.  Click on the big button Firmware Updater 2078. This will take a few seconds and when it is 
done updating it will give you a message Update Successful. Click on the OK button and unplug and 
replug the USB cable to recycle the power of USB Controller and you are done with the firmware 
update.  
 
If you are simply updating the USB controller board firmware or updating the LinkMotion driver 
version then you will simply need to exit the LinkMotion applet by right mouse click and Re-Launch it 
from the Start menu and start working with it again. 
 
Make sure and understand the LinkMotion driver features and then work on your machine. 
It is always a good idea and a good practice to turn on the PC first and your controller/driver 
module later. In the same manner, it is always a good Idea to turn off the PC last when you switch 
off the system. 
 
 
Warnings for Older USB Controller board Series 10000 and under: 
 

10. Plug the LinkMotion controller cable directly into your computer’s USB 2.0 connection. 
11. It is important to experiment and determine that the USB controller works with the USB hub or 

extension device if the user plans to use such a device. 
12. This USB controller does not work with USB1.1 connections. If you connect other USB devices 

compatible only with 1.1, it may cause problems. All the USB devices including keyboard and 
mouse in the system shall comply with 2.0 specifications. Always check compatibility for 
wireless USB devices, if you are using one. 

13. Power saver and Screen Saver modes on your computer should be turned off. If these modes are 
activated, it can cause problems in recognizing the USB connection on a continuous basis. 

14. The LinkMotion USB controller can be configured to power either from the USB connection of 
the PC or from an external 5 VDC power supply. There is a jumper on the controller board that 
allows the selection of the power supply for the controller. 

15. In case of Laptop computers, AC power unit shall be connected to an AC outlet while operating 
external USB devices. Sometimes, aggressive power save mode settings under battery operations 
could activate the disconnection of USB devices. Re-Launching LinkMotion will re-activate the 
communication in such a situation. 

16. Approximately 1 minute of machine operation uses 1MB of SD memory for vector work. This 
controller supports up to 4GB Memory. If you are using LinkMotion version 3.5 or higher, you 
could use either SD or SDHC memory cards. 

17. It is impossible to test all the available SD Memory cards in the market but we have listed in the 
following lists ones that work and ones that do not work with this USB controller. 

 
Memory chips tested and working with this controller: Sandisk (1 GB, 512 MB, 256 MB), Topram 1gb, 
PNY 1gb, PNY 4gb SDHC, Samsung 1gb, Transcend 1gb and 'Made in China Generic' 1gb. 
 
Memory chips found not working with this controller: Kingston 2gb (not SDHC) and 4gb SDHC. 
 

18. If serial number of the controller is not recognized by LinkMotion then user will see a message 



“Unrecognized serial number ______”. Once you click on OK button it will display the second 
message as “The maximum working area is 1”x1” or 25.4mm x 25.4mm. LinkMotion software 
can output only 1”x1” jobs at that point. Unauthorized controller bought from unauthorized 
vendors can cause this kind of problem. Get in touch with Solustan to verify your serial number. 
Not making proper USB connection with the controller can also display this kind of message and 
simply disconnecting USB cable form computer end and reconnect and re-launch LinkMotion 
should resolve it. 
 

      10. USB Controller Board Lights: 
 
Older AGNI USB Controllers / Series 10000 - There are three LED lights available to attach to the 
Agni Controller board – Blue, Amber, and Red. These lights behave in the following manner when 
connections are made and the board is powered: 
 
Blue LED Flashing Slowly – No USB Connection 
Blue LED Steady – USB powered up and ready 
Amber LED Flashing Slowly – Waiting for firmware update 
Amber LED Flashing Fast – No SD (Memory) card 
Amber LED Steady – USB ready with SD card 
Red LED – Turns on when the board is powered. It turns off when it makes a proper connection with 
LinkMotion. It also turns on every time when any machine motion is detected. 
Red LED Flashing – If hardware switch for Repeat is installed on the Laser/Agni controller and 
LinkMotion.INI file is set up properly, then, Red LED starts flashing after a job is processed one time. 
Pressing the Repeat switch will send the job again to the machine. After a job is processed one time it is 
ready to repeat the last job using the repeat button on the USB controller as many times as user wishes. 
 


